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Questions that can be answered by AUC

* |s sample heterogeneous!
* in molecular weight, shape, or both!?
* does heterogeneity depend on pH, salt, buffer, etc?

* |s sample pure enough for MX, SAXS, SANS, NMR!?

* What is sedimentation & diffusion coefficient!?

* Globular or unfolded/disordered?
* Is conformation dependent on salt, pH, ligand concentration,
deuteration, tagging, mutations etc!?



Questions that can be answered by AUC

* Does sample...
* ...self-associate?

° ...aggregate!

* What is M of sample!?

* Does sample bind to a ligand?
* What is stoichiometry of binding?
* Whatis K?

* |Is K, affected by salt, pH, ligand concentration, deuteration, tagging,
mutations etc!?

* Is sample affected by crowding!?



Advantages of AUC

* In solution

* Non-destructive

* Self-cleaning

* Absolute

* Complementary

* Can analyse (nearly) anything

* Proteins

* Nucleic acids

* Carbohydrates
* Polymers

* Colloids

* Complexes




AUC: a high speed preparative UC with optics
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*  Choice of 3 instruments

Beckman Coulter
* ProteomelLab XL-A/XL-I
* Optima AUC

* https://www.beckman.com/centrifuges/analytical-ultracentrifuges

Spin Analytical CFA
* http://www.spinanalytical.com/cfa.php

&2 Spin Analytical



Inside the Beckman Coulter XL-| rotor chamber

image from Analytical Ultracentrifuge User Guide Volume |: Hardware, K. L. Planken & V. Schirf, 2008 (http://www.ultrascan.uthscsa.edu)



Inside the Beckman Coulter XL-I
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Relationship between data and sample
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https://www.beckman.com/centrifuges/analytical-ultracentrifuges/proteomelab-xI-a-xI-i
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Sedimentation velocity (SV): shape & homogeneity

absorbance

t=0

radius

t=I h

t=3 h

heterogeneity determination
sedimentation (s) & diffusion (D)

coefficients (shape)
association/dissociation constant (K_/K )

stoichiometry



Sedimentation equilibrium (SE): mass & self-association

M

‘ association/dissociation constant (K,/K,)
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non-ideality (B)
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Which optical system!?

_ Absorbance Interference Fluorescence

Lowest conc A, =0.1 0.05 mg/ml 100 PM f0rescein
Dynamic range 2-3 logs 3-4 logs 6-8 logs
Radial res’'n (um) 20-50 10 20-50
Scan time (s/cell) =60 1 = 15
Utility * Selectivity * Buffer absorbs, sample doesn’t * Selectivity
* Sensitivity * Variable extinction coefficient * Sensitivity
* Non-dialysables ¢ Short column equilibrium * Non-dialysables
* Rapid sedimenters * Limited sample

Adapted from a slide by Tom Laue



Sample preparation

Purify by gel filtration or similar

* Unless you want to know what is in solution in its entirety

* Estimate concentration
* Using e.g. NanoDrop

(Dialyse sample against the desired solvent)
* Possible problems with detergents

* Required for interference optics only

Choose windows
* Sapphire windows

* Necessary for interference optics
* Good for all AUC optics

*  Quartz windows

* No good for interference



Sample requirements =

Sample volume
- SV
* 360 pl (12 mm pathlength)
* 90 pl (3 mm pathlength)
- SE
e 80 pl (2- or 6-channel centrepiece)
* 20 pl (8-channel centrepiece - interference optics only)

Sample concentration
* Absorbance optics:A,= 0.1-1.0 (12 mm pathlength)
* A= 180-800 nm
* Interference optics: typically 0.05-30 mg/ml

Sample reference
* Absorbance optics: can be column eluant or dialysate better
* Interference optics: must be dialysate

Typical multiplexing: 3 or 7 sample holders (“cells”)/run
* Up to 28 samples per run




SV: radial movement recorded as function of time
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absorbance @ 280 nm
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radius (cm)




Interference optics acquire refractive index data
rapidly, independent of chromophores

hemocyanin sedimentation observed with interference optics



°
. data recorded until no change
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Almost all AUC data analysis software is freely
available — here are the most widely used

* The RASMB website

* “Reversible Associations in Structural and Molecular Biology”
* http://www.rasmb.org/
* Access to freely available software

* Subscription to AUC-related discussion group

* Schuck lab (SEDFIT, SEDPHAT)

* http://www.analyticalultracentrifugation.com/default.htm

* Demeler lab (UltraScan Ill)
* including US-SOMO

* http://www.ultrascan.uthscsa.edu/




SV important equations

The Lamm equation describes SV

* s is particle velocity per unit centrifugal field

*  Svedberg equation relates s,D and M

*  Stokes-Einstein equation

*  Combining Svedberg with Stokes-Einstein
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s is influenced by solvent density & viscosity and
sample partial specific volume (psv or vbar)

sample partial : : :
: solvent density  solvent viscosity
specific volume

= | /density \ I /

20,w Tb
’ |-V )
/ ( P)ry M0,w
sedimentation coefficient experimental sedimentation
standardised to solvent of . coefficient determined in e.g.
water @ 20°C = 1.5 for typical aqueous buffer (b) at T°C

solvent at 4°C



SEDNTERP: Calculation of p,n & psv

Sednterp/App

| Calculate Buffer Density
Density 1.0318

| Calculate Buffer Viscosity

Viscosity 1.14100e-02

Components

Sodium carbonate

Sodium chloride

Sodium citrate

Sednterp.app/Contents/MacOS/../Database/sednterp.db

Sodium diatrizoate

Sodium dichromate

Sodium ferrocyanide

Sodium hydroxide

Sodium molybdate

Sodium nitrate

| Heavy Isotopes of Water

H:0  100.00% Volume

D:0 0.00% Volume S
H:0"* 0.00% Volume z
D:0" 0.00% Volume %

Ready

Density Corrected for Temperature & Isotopes of Water 1.0336
Viscosity Corrected for Temperature 1.78432e-02
Buffer Components Concentration Units

Sodium chloride 0.15 molar
Sodium phosphate, di-basic | 0.20 molar

[93

Compute
$a
Search pH

Read Composition from File

Save Composition to File

Save Solvent to Database

Cancel OK

http://rasmb.org/sednterp/



Values for vbar

vbar (mi/g)

Protein 0.73
Can be reliably calculated from sequence
Carbohydrate 0.63

An average value

Hpte L0 Close to value for solvent, therefore almost invisible

Detergent 0.7-1.2 Can sediment or float



SEDFIT c(s) analysis: how many species + s of species
|: Load SV data

SEDIMENTATION ANALYSIS -> Z:\DocumentsiHonours Projectsk2010\PhtDY3894111 7104160545001 50.1P2...
Data Copy Display Model Parameters Run Fit Generate Statistics Notes Options Plot Help

remoo: Tiawd RI

| resore Thoke

http://www.analyticalultracentrifugation.com/default.htm



2: Specify parameters

| remow: Tlawd RI
I resore Tl oke

B Continuous Sedimentation Coefficient Distribution c(s)

resolution 200 partial spec. volume  |0.7164
Sty 0.00000 buffer density 1.0034
s max

! buffer viscosity (Poise] |0.01567
[V frictional ratic {1.20000

™ s grid from file
™ Baselin 0.00000 I log spaced s grid
[V FitRlNoise ¥ Fit Time Independent Noise

™ Meniscu: |5.8003
™ Bottom |7.2195

confidence level (F-ratio) |g‘ 95000

B |

TTAT[TTT T[T Ir [T

http://www.analyticalultracentrifugation.com/default.htm



3: Set meniscus, cell base and analysis limits

SEDIMENTATION ANALYSIS -> Z:\DocumentsiHonours Projects}y2010YPhtDY38941 1171041 60545100150.1P2...
Data Copy Display Model Parameters Run Fit Generate Statistics MNotes Options Plot Help

| remoo: TIawd RI

¥ ractnre Thanka
1

http://www.analyticalultracentrifugation.com/default.htm



4: Run

SEDIMENTATION ANALYSIS -> Z:\DocumentsiHonours Projectst2010YPhtDi389%111 71031 605454001 50.1P2...

Data Copy Display Model Parameters Run Fit Generate Statistics MNotes Options Plot Help
- . | remow: Tiavd Rl
fitting files 00002.IP2I to 001 50.I!32 . . ‘ ‘ . . . . [ FDRTTvo )

[

s0, step Hl,]n .
=

rmsd=0.028q76 [(n=233185,SSR=183.816853)
ME regularizlation P=0.95
frict ratio = 1.200000
¥
Meniscus = :5.947402
Bottom = 7.1 IBBBBS
fitting 5.9621-].- 7.1071
Baseline = l].y[ll]l]lll]l]
v

Runs test Z (#stddev) = 378.95
vbar = 0.7164 [fix]

213.‘171\:?‘

10—+

c(s)

sed coefficiert [5)

http://www.analyticalultracentrifugation.com/default.htm



5: Subtract time and radial invariant noise

SEDIMENTATION ANALYSIS -> Z:\DocumentsiHonours Projectsi2010¥PhtD¥3891111710%160545400150.1P2...
Data Copy Display Model Parameters Run Fit Generate Statistics Motes Options Plot Help

| remco: Tlawd RI

1 1 1 1 1 1 I I 1 1 1 I fesore Tl wolse

00067.1P2

zzmn_ﬁ 3 - P - == e R e
E E o T T T T T T T T

10 — —
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0 T T T T T T T T

0 1 2 3 + 3 ¢ 7

sed coefficient [S]

http://www.analyticalultracentrifugation.com/default.htm



6: Fit (with solutions to the Lamm equation)

SEDIMENTATION ANALYSIS -> Z:\DocumentsiHonours Projects}i2010YPhtDy38941 1171041 605454001 50.1P2...
Data Copy Display Model Parameters Run Fit Generate Statistics MNotes Options Plot Help

| remov: Tiawd RI
| I resore Tlioke

gk

sed coefficiert 5]

http://www.analyticalultracentrifugation.com/default.htm



/: Integrate to obtain estimate of concentration of
species and weight-average values

SEDIMENTATION ANALYSIS -> Z:\DocumentsiHonours Projectsi2010WPhtD¥38911117101160545100150.1P2...

Data Copy lodel Parameters Run Fit Generate Statistics MNotes Options Plot Help
| remow TiadRI
| | resorThoke
3
1
0
Bl o T ek LT - SH
P Py, gl - iy
B0 ,“ .M'Lb:““ R e
-149012 g
E INTEGRATE DISTRIBUTION X]
. , . Integral from 3.438889 to 4.703889: InEgrae
8 Loading Concentration [Signal] = 1.187269 (33.936%0f total)
E Weight (Signal) Average = 4.048657
7 Std. deviation[as sqrt{second central moment)] = 0.181 {best done without regularization)

sw transformed to 20,w conditions = 6.514584

3
=]
ik
3
2] A
13
3 T T T T T T T T v T T T T T T T T T T T T T ¥ T T
2 3 + 3

sed coefficient 5]

=

http://www.analyticalultracentrifugation.com/default.htm



Sum of Lamm equations 0 < s < |2 S discretised by

200

M Windows 7 - Parallels Desktop

Data Copy Display Model Parameters Run Fit Generate Statistics Notes Options Plot

fitting files 00001.1P1 to 00120.1P1

s8, step #10

rmsd=l].l]4733:;i (n=147840,58R=331.220742)
ME legnluriza}inn‘ P=0.95
frict ratio = 2.111780

Meniscu

Bottom = 7.;

).

Runs test Z (#stddev) = 357.17
v 7

vbar = 0.7300 (fix

.7_45055%3

cls)

) w . w
S =3 S =

sl Lo b by v a b

=

=)

o
w
=

sed coefficient [S]

LI B

6 PM

1/8/2014

E§OQFRAO@29@ »

2



Integrating c(s) peaks reveals region of boundary that
contains species

M Windows 7 - Parallels Desktop "

1012\]
Parameters Run Fit Generate Statistics Notes Options Plot Help

Data Copy Display Model

remove Tl and RI

restore Tl

6.2 6.3 64 6.5 6.6 6.7 6.8 6.9 7 71

i INTEGRATE DISTRIB

Integral from 0895238 to 1.428571:
Loading Concentration [Signal] = 7.289959 (43.148%of total)
Weight (Signal) Average = 1.181411
Std. deviati central = 0059 (best done without

regularization)
sw transformed to 20,w conditions = 1.187065

745058

integrate

8 3

w
S

o(s)

<}
S

S

.

sed coefficient [S]

4:27PM
1/8/2014

E ’ B OFHMO®O® [ %

A 3




Integrating c(s) peaks reveals region of boundary that
contains species

Data

w
=

5

isplay Model

M Windows 7 - Parallels Desktop i

Run Fit Generate Statistics Notes Options Plot Help

6.3 64 6.5 6.6 6.7 6.8 6.9 7 71

i INTEGRATE DISTRIB

Integral from 1438095 to 2.057143:
Loading Concentration [Signal] = 1.208014 (7.683%of total)
Weight (Signal) Average = 1.674725
Std. deviati central = 0.108 (best done without

regularization)

sw transformed to 20,w conditions = 1.682739

integrate

sed coefficient [S]

EHIOQFHM I @@ [ #



Integrating c(s) peaks reveals region of boundary that
contains species

M Windows 7 - Parallels Desktop =

Data Parameters Run Fit Generate Statistics Notes Options Plot Help

Integral from 5.076190 to 7.533333:

Loading Concentration [Signal] = 4.310431 (25.513%of total)

Weight (Signal) Average = 6.023970

Std. deviati central = 0.540 (best done without

regularization)
sw transformed to 20,w conditions = 6.052798

w
=

&

cls)

<}
S

5

>

sed coefficient [S]

O~ BEBIOQFHAO@® » %



Integrating c(s) peaks reveals region of boundary that
contains species

8 Windows 7 - Parallels Desktop =

isplay Model Parameters Run Fit Generate ~Statistics Notes Options Plot Help

Integral from 7.523809 to 9.390476:

Loading Concentration [Signal] = 1.982911 (11.736%of total)

Weight (Signal) Average = 8.494414

Std. deviati central = 0450 (best done without

regularization)
sw transformed to 20,w conditions = 8.535066

w
=

&

cls)

<}
S

5

=3

sed coefficient [S]

(© -] BEBIOQFHAO@® » %



Integrating c(s) peaks reveals region of boundary that
contains species

8 Windows 7 - Parallels Desktop =

isplay Model Parameters Run Fit Generate ~Statistics Notes Options Plot Help

Integral from 9.466666 to 10.676190:

Loading Concentration [Signal] = 0.655447 (3:879%of total)

Weight (Signal) Average = 9.907234

Std. deviati central = 0.249 (best done without

regularization)
sw transformed to 20,w conditions = 9.954646

w
=

&

cls)

<}
S

5

=3

sed coefficient [S]

(© -] BEBIOQFHAO@® » %



Integrating c(s) peaks reveals region of boundary that
contains species

8 Windows 7 - Parallels Desktop =

isplay Model Parameters Run Fit Generate ~Statistics Notes Options Plot Help

Integral from 11.752381 to 12.190476:

Loading Concentration [Signal] = 1.061641 (6.284%of total)

Weight (Signal) Average = 11.979362

Std. deviati central = 0038 (best done without

regularization)
sw transformed to 20,w conditions = 12.036690

cls)

20

L B

0 / T y T T T : : ; 7 .

sed coefficient [S]

(© -] BEBIOQFHAO@® » %



Two-dimensional spectrum analysis (2DSA) of SV data
with UltraScan: model independent fitting giving s &
M

* Important when f/f, varies for components

a
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) Zhang et al., Anal. Chem. (2017) doi: 10.1021/acs.analchem.6b03926



Interacting systems & monodispersity

* Rapid monomer-dimer
* SV will show | symmetrical boundary
* Can be confused with monodispersity

* Position will correspond to average of s & Sgimer

monomer

* Slow monomer-dimer
* Indistinguishable from mixture of monomer and dimer

* Therefore 2 peaks, or asymmetric single peak
* Except if proportion of species depends on loading concentration



Life-time of FAM-GIuA2 ATD dimer is significantly
longer than that of Dylight488- or EGFP-GIuA2 ATD

s distributions c(s)

6 A = e
* =
O =~
Dylight488-GluA2 ATD £ 2. | —
N
.
7

s —

EGFP-GluA2 ATD 3 i
E 2 e
2

2 3 4 5 6 7
sedimentation coefficient (S)

FAM-GluA2 ATD

2 3 4 5 6 7
sedimentation coefficient (S)

residuals  weighted s-value (S)

residuals  weighted s-value (S)

resiguals  weighted s-value (S)

s,, isotherms

5.0-B

454
40+

35} "

0.03 ¥ t " * t
0.00 + \/\_/\
-0.03

107%107""10™ 10 10°® 107 10 10° 10
concentration (M)

0.04 Eu e bbb

0.0} \/\/\

-0.04

1072107107 10"° 10°* 107 10" 10 10™
concentration (M)

ol F

45t

40}

Y] Sreerna W,
0¢m .y " . " r Al "
000} M :
-0.05 | ..

107?107""107"° 10 10°® 107 10 107° 10
concentration (M)

Ky =20.5 nM
s;=3.52S5,s5,=5.215

Kp =25.4nM
s;=4.26S5,5,=6.445

Kp=2.3nM
s;=3.525,5,=5.045

Zhao H, Lomash S, Glasser C, Mayer ML, Schuck P (2013) PLoS ONE 8(12): e83439. doi:10.137/journal.pone.0083439






Self-association: “deconvolution” of SE data into
individual components

12

1.0F

0.8

0.6f

absorbance

0.4f

0.2f

experimental data = sum of
species

0.0

6.4

6.5

6.6 6.7 6.8 6.9

radius (cm)

7.0

tetramer

dimer

monomer



Self-association:

SE data are the sum of exponentials

A, =explInA, +HM(r? —ré)] <—monomer
+exp[n,InAj +InKa, +n2.H.I\/I(r2 —rg)] — I-n,
+exp[nzInAy +InKa; +n3.H.M(r2—r§)] — l-n,
+exp[n,InAy +InKa, +n4.H.M(r2 —r§)]+E «~— |-n,




Self-association: best model revealed by residuals
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SEDPHAT: species analysis: monomer + heavy

M| Windows 7 - Parallels Desktop

N
Data Copy Display Model Global Parameters Concentrati Experi P Run Fit Constraints Statistics Options Plot Help
L 1 L I I 1 _||I||||I|x||I||||I||||I.||x _|||I||||I||||I||||I||||I|| IR S T S SN SN SR S S ST |||I||||I||||I||||I||||I||||
5|m #43 5|mplex #3 step #0 J 1 “ E LEIH 0.6 H—E,E() 251} ’ j 4 & 5 i
glob red chisq = 1.701837e+01 (n = 2173) B r i i .
locrmsd=0.006064 (n=127) - 077 0.004786 (n=165) T 4|0.007368 (n=178) L 0.003349 (n=165) op;os1s(n=302) L
“24,(230 xp i ] ©524k280.xp | E 1| e324k280.xp [ c724Kk280.xp c224Ki.xp 7 | C
i 1 F 0.5 - C
(vbar20=0.7260 ) L 0.6 . L 02 : C
M = 14267.000 | 101077.141 | T ] Eooql - : C
s= 1700|3200[ L 05 E 04_— o 31 o
I 0.407 | 0.062 | F 7" Jt10.25110.159] L (0.105]0.079 | 2.5880.146 | C
b ] 1.845e+04 o/ ]|1.845e+04 [ 1.845e+04 3.923e+04 | r
2 — 0.4 Baseline = -0.0’376 C 03 | | Baseline = -0.0093 o Basgllme =-0.0116 Basellne = -1 3928 -
— O 7 t=4.0C,d=1.00705g/ml C ’ 7 | t=4.0C,d=1.00705g/ml C t=4.0C,d=1.00705g/ml t=4 OC d=1. 00705glm| C
4 - 03 6.9463 -7.1611 C B 6.9363 -7.1698 - 6. 9567 7. 1791 S 9488 7.1671 C
Meniscus = 6.933000 - 1k 6.935200 4 C 02| 6.923900 TE 6924200 sszasoo ]! C
Bottom 7. 198100 __ ] 7.181800 r 11|7.186700 C 7. 193700 7 182500 ] : o
N [ 02+ - ] [ 0.054 . 1! r
1 L 11, C o014 -1 -3 o0 C
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SEDPHAT: species analysis: monomer + “dimer”
(both fixed) + heavy

M Windows 7 - Parallels Desktop
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SEDPHAT: species analysis: monomer (fixed) +
“dimer” + heavy (both free)

M Windows 7 - Parallels Desktop
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SEDPHAT:Abs + interference, 5.4 — 54 uM,
Kd=10.8 uM

M Windows 7 - Parallels Desktop
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SEDPHAT:Abs + interference, 5.4 — 54 uM,
Kd =7.4 x10° pM?
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SEDPHAT:Abs + interference, 5.4 — 54 uM,
Kd = 1.7 x10° yM?3
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SE: more than just mass

250 T | | | |
. 225F o
dimer mass
11|
e «
= A75F : -
— ’ If-associati
< - o) self-association
o 150 ,’I .
- /
2; 125_7’ ideal monomer B
1
1000 5o .
L - - —6 _____ ° _ ___
/ SF  non-ideality LAt e__7
monomer g ! ! ! ! !
mass 0 1 2 3 4 5 6

monomer loading concentration (pM)



ldeal monomer

* Globular molecule
* Not highly charged
* Areas of charge neutralised by salt in buffer

* Sediments with monomer mass at most normal
concentrations

* Examples: lysozyme, Fab, etc.




6104 —r——————————
o 0-4. PR r _
-6-10'4- e s e w e UG
1. 22—

|deal monomer
data

residuals
)
|
{

1.0
0.8}
0.6

absorbance

0.4}
0.2

0.0w" C e il M T N | )
6.4 6.5 6.6 6.7 6.8 6.9 7.0

radius (cm)



Non-ideal monomer

* Asymmetric molecule

and/or

Highly charged

* Areas of charge not neutralised by salt in buffer

Sediments with mass below that of monomer
* Mass is dependent on concentration

* Examples: myosin, fibrinogen etc.




What is non-ideality

non-ideal

ideal

elongated
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Hetero-association example:
PDC E3BP:E3 sub-complex

. forms a homo-dimer
E3BP binds to
Native PAGE & ITC shows 2:| complex

Needed confirmation

Smolle et al., JBC 28/ 19771-80 (2006)



SV titration: stoichiometry is 2:

*  Expt I:SV of =3 alone; SV of E3BP-DD alone § w BBPPD E
* Determine their s 08 §
*  Expt 2:SV of different E3BP-DD+L3 ratios @ o] ;
At what ratio does E3BP-DD peak 04-
vanish? .
* This reveals stoichiometry: 2:1 00
B

* Note 2 complex peaks
* Different conformations
* s =6 S peak less compact

c(s)

* s =8 S peak more compact

Mischa Smolle
Smolle et al., JBC 281 19771-80 (2006)




SE titration: stoichiometry is 2:

*  Whole-cell weight-average M o R
(My2pp) determined 145] o e360.00), ’
* e.g.using species analysis in SEDPHAT 140
with | species only 35
. del d ] /
No model assume g o] g i/
*  When E3BP-DD is in excess g 125 ] (38500 -
g =] Shtig)
* Mo <.MC.onrlplex until complex is formed g“’ 2 I/ 1 i;i
*  When E3 is in excess s &1
* M, app < Mcomplex DECaUSE excess 110 - L
lowers M 1
W.app 105 | o
c M Wh)’ Mw,app e Mcomplex at 2:1222 s 31 21 11 12
* Non-ideality E3BP-DD:(3 molar ratio

Mischa Smolle
Smolle et al., JBC 281 19771-80 (2006)
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lllustrative movie of association of 140 detergent
molecules with membrane protein FhaC

Gabel, Lensink, Clantin, Jacob-Dubuisson, Villeret & Ebel, C. (2014). Biophys. J. 107, 185-196.



Detergent solublised proteins are complex mixtures




Sedimentation velocity of proteins solubilised in
detergent

Methods 54 (2011) 56-66

Contents lists available at ScienceDirect

Methods .

ELSEVIER journal homepage: www.elsevier.com/locate/ymeth

Review Article

Sedimentation velocity to characterize surfactants and solubilized
membrane proteins

Christine Ebel ®P<*

2CEA, Institut de Biologie Structurale, IBS, Grenoble, 41 rue Jules Horowitz, F-38027 Grenoble, France
PCNRS, UMR 5075, IBS, 41 rue Jules Horowitz, F-38027 Grenoble, France
€Université Joseph Fourier, IBS, 41 rue Jules Horowitz, F-38027 Grenoble, France



Values for vbar (psv)

vbar (mi/g)

Protein 0.73 Can be calculated from sequence quite reliably
Carbohydrate 0.63 Can be calculated from sequence quite reliably
Hpte L0 élr(]):?c(r)asael:j:oer solvent, therefore almost invisible
Detergent 0.7-1.2 Can sediment or float

CqE: 0.95

LAPAO 1.002 Doesn’t sediment

Octyl-POE 0.997

Triton X-100 Absorbs @ 280 nm

LDAO 1.13 Floats

DDM 0.82 Aggregation number = 130



SV of AcrB in DDM ) W ;

o
~

A280

residuals

J

residuals

o
(V)

o
o

0.04

-0.04 t

25t
207t

62 64 66 68 7.0
radius (cm)

15 7. 8%,

10
05

0.0 | I

0.1}
-0.1 ¢

62 64 66 6.8 7.0
radius (cm)

__— Dimer of trimers

0 5 10 15 20 25 30 3
s(S)

* s= 149 S for 66% of material
(protein-detergent)

* s = 3.3 S (observed from A))
(micelles)

Ebel, Methods (201 1) doi: 10.1016/j.ymeth.2010.11.00
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s = deviation from sphericity + hydrodynamic hydration

_M(1-vp)
N, f

S




Sedimentation coefficient is a constraint for SAS
modelling

* For one sphere fo = 6mnoo
N
e For an assembly of N spheres ~ Fi = —f; (u; — v}) —fiz T;;F;
j=
 where T, = 1 I+ R;R;
8 77()Rij Rizj

Byron, O., Introduction: Calculation of hydrodynamic parameters in Analytical Ultracentrifugation: Instrumentation, Software and
Application (S. Uchiyama, F. Arisaka, W. F. Stafford and T. Laue, editors), 2016, Springer.



Several freely available programs for HBM

* José Garcia de la Torre et al.
* http://leonardo.inf.um.es/macromol/programs/programs.htm

 HYDRO++
* Computes hydrodynamic & other parameters for any bead model
 HYDROPRO

* Computes hydrodynamic & other parameters for models constructed from pdb files
* And many other programs....

* Mattia Rocco, Emre Brookes
* http://somo.uthscsa.edu/
«  US-SOMO
* AtoB and SoMo

* Generates HBMs from pdb files, computes hydrodynamic & other parameters
with “realistic” hydration

* BEST (Sergio Aragon)

* Boundary element modeling — very precise, computationally intensive
 Zeno

* Electrostatic-hydrodynamic analogy

Reviewed in Byron (2008) Methods in Cell Biology 84, 327-373
See also Rocco & Byron, Methods in Enzymology (2015) 562, 81-108



Different HM methods have
their own pros and cons

®

SoMo (0O/L) \

i€ ik

Rocco & Byron, Methods in Enzymology (2015) 562, 81-108
Rocco & Byron, European Biophysics Journal (2015) 44,417-431



SOMO is a subprogram of UltraScan |l

Version 4.0 ( Revision: 2395 ) for 0S-X

Author: Borries Demeler

The University of Texas
Health Science Center at San Antonio
Department of Blochemistry

Loaded SOMO Rigid Body and Brownian Dynamics Bead Modeling...

Mattia Rocco/ Borries Demeler/ Emre Brooks
Rai et al. (2005) Structure |3 723-34; Brookes et al. (2010) Eur. Biophys. J; Brookes et al., (2010) Macromol. Biosci.
http://somo.uthscsa.edu



Select from Simulation drop-down menu

@ us Edit Velocity Utilities Multiwavelength BSIUTELCul Database Help

L = sa%[¥) Fri130 Q @ =

S Finite Element Simulation (ASTFEM) F' —

Estimate Equilibrium Times

Self-Association Equilibrium

Model s, D and f from MW for 4 basic shapes
Predict f and axial ratios for 4 basic shapes
SOMO Bead Modeling

SOMO Configuration

Version 4.0 ( Revision: 2395 ) for 0S-X

Author: Borries Demeler

The University of Texas
Health Science Center at San Antonio
Department of Biochemistry

Loaded SOMO Rigid Body and Brownian Dynamics Bead Modeling...

“—“

http://somo.uthscsa.edu



|: Load PDB file

@ Grab File Edit Capture Window Help [ = 55% (%) Fri13da Q @ =

I PDB Functions:

Select Lookup Table Applicati residue Non-default options:
SOMO Options -> SoMo Overlap Reduction -> Bead Overlap Tolerance: 0.002

Batch Mode/Cluster Operation

posdSiole BDE Ele Previously used directories

Please select a PDB Structure: N
Directory Last access Last type loaded

e D e, | DS Ectoy ] /Users/owyn/Documents/Liyana Azmipdbs 08/12/2017 11:11 -pdb

SAXS/SANS Functions
iyana AXS 08/12/2017 10:15 -pdb

‘g/ Bead Model Functions:

Bead Model Suffix: A20RS0hIOT /A
Overwrite existing filenames 72 Add auto-genel

View ASA Results

Batch Mode/Cluster Operation

Load Single Bead Model File

Select Parameters to be Saved

BEST Model classifier

Help Config

http://somo.uthscsa.edu



2: File read, checked for compatibility, displayed with
RasMol

@ Grab File Edit Capture Window Help L = 7% Fri1n3g Q @ =

volume
PDB Functions:

Warning: hybrid_map name missing for hybrid_name C4H1, not added to excluded
Select Lookup Table

x:::i]:g: hybrid_map name missing for hybrid_name C3HO0, not added to excluded
VWO:rJ:;:g: hybrid_map name missing for hybrid_name O1HO, not added to excluded
vwo::rr:sg: hybrid_map name missing for hybrid_name C4H3, not added to excluded
VWO:::\?:Q: hybrid_map name missing for hybrid_name N3H1, not added to excluded
vwoel:rjrr:?:g: hybrid_map name missing for hybrid_name C4H1, not added to excluded
;\?;:rr:i‘:g: hybrid_map name missing for hybrid_name C3HO, not added to excluded
VWO:::\?:Q: hybrid_map name missing for hybrid_name O1HO, not added to excluded
vwoelal:rr:?:g: hybrid_map name missing for hybrid_name C4H2, not added to excluded
volume

Batch Mode/Cluster Operation

Load Single PDB File lyana Azmi/pdbs/AdhE_D1_predicted_171207.pdb
Please select a PDB Structure:

View/Edit PDB File  PDB Editor

SAXS/SANS Functions

Run DMD

A20R50hiOT / A10R30syOThyGS / A20RS0

Overwrite existing filenames 7 Add auto-generated sufix Warning: hybrid_map name missing for hybrid_name C4H2, not added to excluded
volume
2K Doad Buld Aiob (Crid) Boad Nodo) Warning: hybrid_map name missing for hybrid_name C3HO0, not added to excluded
Build SoMo Overlap Bead Model Build AtoB (Grid) Overlap Bead Model volume X/ RasMol - AdhE_D1_predicted_1712...
Warning: hybrid_map name missing for hybrid_name O1HO, not added to excluded Dicnd . Yrti,
View ASA Results volume
Batch Mode/Cluster Operation View Bead Model File Waluning: hybrid_map name missing for hybrid_name O2H1, not added to excluded
volume
Load Single Bead Model File not selected
Model: 1 Chain: Molecular weight 47685 Daltons, Volume (from vbar) 58833.8 A*3,

Calculto | atomic volume 0 A*3 average electron density nan A*-3

Model: 1 Molecular weight 47685 Daltons, Volume (from vbar) 58833.8 A*3, atomic
Open Hydrodynamic Calculations File volume O A*3 average electron density nan A*-3
D e et TS AdhE_D1_predicted_171207 model 1 47.69 kD, Rg 22.58 A, (Rg/6.5)"3: 41.9212.1%

http://somo.uthscsa.edu



3: Compute & display bead model

@ Grab File Edit

Capture Window Help

A = s8%[(%) Fri1:42 Q @ =

N\ RasMol -

Select Lookup Table

I Batch Mode/Cluster Operation

Load Single PDB File

View/Edit PDB File  PDB Editor

I SAXS/SANS Functions

residue

ana Azmi/pdbs/AdhE_D1_predicted_171207.pdb

I Run DMD
8D
A20RSONOT-50
Overwrite existing filenames 7 Add auto-generated suffix
Build SoMo Bead Model Buikd AtoB (Grid) Bead Model
Build SoMo Overlap Bead Model Build AtoB (Grid) Overlap Bead Model
View ASA Resuits Grid Existing Bead Model Visualize Bead Model
Batch Mode/Cluster Operation View Bead Model File
Load Single Bead Model File AdnE_D1_predicted_171207_1
SAXS/SANS F Calculate Hy

Hydrodynamic Calculations:

Calculate RB Hydrodynamics SMI

Calculate RB Hydrodynamics ZENO

There are 3351 atoms in 1 chain(s) in this model
Creating beads from atomic model

Computing ASA via ASAB1

Return from Computing ASA

Anhydrous volume 59506.41 A*3
There are 864 beads in this model before popping

Begin popping stage 1

Beads popped 0.
Begin radial reduction stage 1

Begin popping stage 2

Beads popped 0.
Begin radial reduction stage 2

Begin popping stage 3

Beads popped 0.
Begin radial reduction stage 3

Finished with popping and radial reduction

Rechecking beads

3 previously buried beads are exposed by rechecking

Finished rechecking beads
Build bead model completed

Visualizing model 1

AdhE_D1_predicted_1712071-A20.bms

http://somo.uthscsa.edu



4: Compute & display hydrodynamic parameters

@ Grab File Edit Capture Window Help ] = 59% (%) Fri14s Q @ i=
:_D1_predicted_171207.1-A20.bms

Rechecking beads

3 previously buried beads are exposed by rechecking

Select Lookup Table icati residue
I Batch Mode/Cluster Operation Finished rechecking beads
Load Single PDB File ana Azmi/pdbs/AdhE_D1_predicted_171207.pdb

Build bead model completed

Visualizing model 1
View/Edit PDB File  PDB Editor

SAXS/SANS Functio .
l unctions Non-default options:

l Run DMD SOMO Options -> SoMo Overlap Reduction -> Bead Overlap Tolerance: 0.002

BD
To reset to default: Menu bar -> Configuration -> Reset to Default Confic

A20R50hIOT-s0 SOMO Hydrodynamic Results

Begin hydrodynamic calculations (Water at 20©C)
Overwrite existing filenames /) Add auto-generated suffix gin ny’ V! (Density 1.00194 cP, Viscosity 0.998234 g/ml)
Build SoMo Bead Model Buikd AtoB (Grid) Bead Model
Build SoMo Overlap Bead Model Build AtoB (Grid) Overlap Bead Model Model 1 will be included : dhE_D1_predicted_171207-A20R50hiOT-s0
View ASA Results Grid Existing Bead Model Visualize Bead Model
Total Beads in Model:
Batch Mode/Cluster Operation View Bead Model File .
Processing model 1 bead count 864 vbar 0.743 Used Beads In Model:
Load Single Bead Model File AdhE_D1_predicted_171207_1
Using 260 beads for the matrix Molecular Mass:
SAXS/SANS F Calculate F Part. Spoci. Volume:

Supermatrix inversion Cycle 1 of 3

Sedimentation Coefficient s:

Supermatrix inversion Cycle 2 of 3 Tr. Diffusion Coefficient D: 7.33-07 cmi/sec2

Stokes Radius: 2.93e+00 nm

Supermatrix inversion Cycle 3 of 3

Frictional Ratio: 1.21

Calculate hydrodynamics completed Radius of Gyration: 2.30e+00 nm

Relaxation Time, tau(h): 3.18e+01 ns

Intrinsic Viscosity: 3.77e+00 cm"3/g

View Bead Model File

View Full Hydrodynamics Results File

http://somo.uthscsa.edu



Can also upload DAMs to SOMO

@ us3_somo Lookup Tables SOMO MD PDB Configuration File O = 60%#) Fri147 Q @ =
SOMO Solution Modeler

Rechecking beads

Select Lookup Table all residue 3 previously buried beads are exposed by rechecking
| Batch ModelCluster Operation _ &) 2 =) = SAXS S h O Q
yana Azmi/pdbs/AdhE_C Favorites C 160926 Bea...lication.docx
B Al My Fil ) 02_SASDCK3._fit1_model1_dammif.pdb
B D2_SASDCK...1_damfilt.pdb
View/Edit PDB File  PDB Editor & iCloud Drive SASBDB links
I SAXS/SANS Functions A\ Applications SAXS July 2016 >
SAXS Nov 2015 >
| Run DMD [ Desktop SAXS Sept 2015-renamed >
M Documents
o Downloads
Devices
Overwrite existing filenames 72 Add g . .
Remote Disc
. aal © D2_SASDCK3_fit1_model1_dammif.pdb
Build SoMo Overlap Bead Model Build AtoB (( Tags OpenOffice Document - 91 KB
View ASA Results Grid Existing Bead T T
DAMMIN/DAMMIF/DAMAVER (‘.pdbja
Batch Mode/Cluster Operation View
Losd Siogle Bead ModelEie AdhE_D1_preg New Folder Options Cancel Open
SAXS/SANS F Calcu
IW Supermatrix inversion Cycle 1 of 3
Calculate RB Hydrodynamics SMI Calculate RB Hydrodynamics ZENO Supermatrix inversion Cycle 2 of 3
I Show Hydrodynamic Calculations Open Hydrodynamic Calculations File Supermatrix inversion Cycle 3 of 3
Select Parameters to be Saved Save parameters to file
Calculate hydrodynamics completed
BEST Model classifier Close
Help Config

http://somo.uthscsa.edu



Input psv and M for model

L = 64%(4%> Fri1344 Q @ :

@ Grab File Edit Capture Window Help

T S
X\ RasMol - D2_SASDCK3_fit1_model1_dammif.pdb

= =

Loading bead model D2_SASDCK3_{
Select Lookup Table Applicati residue

DAMMIN/DAMMIF/DAMAVER/DAM

Batch Mode/Cluster Operation

Load Single PDB File not selected

Please select a PDB Structure:

View/Edit PDBFile PDB Editor
SAXS/SANS Functions
\ Run DMD
8D
| Bead Model Functions:
U A20RSONOT-s0

Overwrite existing filenames 7 Add auto-generated suffix

View ASA Results

Batch Mode/Cluster Operation View Bead Model File

Load Single Bead Model File MI/'SAXS/D2_SASDCK3_fit1_model1_dammif.pdb

SAXS/SANS Functions Calculate Hy
Enter values for vbar and total molecular weight:
Hydrodynamic Calculations:
Enter a vbar value: 0.743
Open Hydrodynamic Calculations File Molecular Weight (Daltons): 47685.0

Select Parameters to be Saved Save parameters to file c:maboadmodeme? Remember these values ?

BEST Model classifier Close Remember for all files that contain: mi/SAXS/D2_SASDCK3_fit1_model1_dammif.pdb

Help Config

Help Close

,"'x,“lx“f,,-"x,- e L o T 1)

http://somo.uthscsa.edu



Convert DAM to HBM

@ Grab File Edit

Capture Window Help

[ = 66%(%) Fri13:49 Q @ =

X\ RasMol - D2_SASDCK3_fit1_model1_dammif.bms

Select Lookup Table residue
Batch Mode/Cluster Operation
Load Single PDB File not selected
View/Edit PDB File  PDB Editor
Run DMD
BD
A10R30syOThyG5-a2bg
Overwrite existing filenames /) Add auto-generated suffix
Build SoMo Bead Model Buikd AtoB (Grid) Bead Model
Build SoMo Overlap Bead Model Build AtoB (Grid) Overlap Bead Model
View ASA Results Grid Existing Bead Model Visualize Bead Model
Batch Mode/Cluster Operation View Bead Model File
Load Single Bead Model File D2_SASDCKS3_fit1_model1_dammif_1
SAXS/SANS F Calculate |

Calculate RB Hydrodynamics SMI Calculate RB Hydrodynamics ZENO
Show Hydrodynamic Calculations Open Hydrodynamic Calculations File
Select Parameters to be Saved Save parameters to file

Model classifier

Rechecking beads

39 previously buried beads are exposed by rechecking

Volume of bead model 29119.5

Build bead model completed

Non-default options:

SOMO Options -> SoMo Overlap Reduction -> Bead Overlap Tolerang

To reset to default: Menu bar -> Configuration -> Reset to Default Co

Begin hydrodynamic calculations

Model Model 1 (from bead model) will be included

Processing model 1 bead count 584 vbar 0.743

Using 471 beads for the matrix

Supermatrix inversion Cycle 1 of 3

Supermatrix inversion Cycle 3 of 3

Calculate hydrodynamics completed

Visualizing model 1

http://somo.uthscsa.edu



Compute hydrodynamics for DAM-HBM:
compare with experimental values

@ Grab File Edit Capture Window Help ) = 66%(%) Fri13:50 Q @ =
| - D2_SASDCK3_fit1_model1_dammif.bms

Supermatrix inversion Cycle 1 of 3

Select L Table ott recidue Supermatrix inversion Cycle 2 of 3
Batch Mode/Cluster Operation Supermatrix inversion Cycle 3 of 3
Load Single PDB File not selected

Calculate hydrodynamics completed

ode om bead mode
PDB St

Visualizing model 1
View/Edit PDB File  PDB Editor

Non-default options:
Run DMD SOMO Options -> SoMo Overlap Reduction -> Bead Overlap Tolerance: 0.002

To reset to default: Menu bar -> Configuration -> Res¢

ode A10R30syOThyG5-a2bg SOMO Hydrodynamic Results
Begin hydrodynamic calculations (Water at 206C)
Overwrito existing flenames ) Add auto-generated suffix gin hydrody (Density 1.00194 cP, Viscosity 0.998234 g/mi)
Build SoMo Bead Model Buikd AtoB (Grid) Bead Model
Build SoMo Overlap Bead Model Build AtoB (Grid) Overlap Bead Model Model Model 1 (from bead model) will be included 1_model1_dammif-A10R30syOThyGS-a2bg
View ASA Results Grid Existing Bead Model Visualize Bead Model : M
Total Beads In Model: 584
Batch Mode/Cluster Operation View Bead Model File .
Processing model 1 bead count 584 vbar 0.743 Used Beads In Model: an
Load Single Bead Model File D2_SASDCK3_fit1_model1_dammif_1 oo Mo PER
- Using 471 beads for the matrix o T ToBAer0e Da
SAXS/SANS F Calculate F Part. Specif. Volume: 0.743 cm”3/g
Calculate RB Hydrodynamics SMI Supermatrix inversion Cycle 2 of 3 Tr. Diffusion Coefficient D: 6.70e-07 cm/sec"2
Stokes Radius: 3.20e+00 nm
Show Hydrodynamic Calculations Supermatrix inversion Cycle 3 of 3
Frictional Ratio: 1.32

Calculate hydrodynamics completed Radius of Gyration: 2.816400 nm

Relaxation Time, tau(h): 4.38e+01 ns

Intrinsic Viscosity: 5.20e+00 cm"3/g

View ASA Results File View Bead Model File

View Full Hydrodynamics Results File

Help Close

http://somo.uthscsa.edu
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Example: Oligomerisation of synthetic polyvalent
integrin ¢ ¢ 3 | ligands

MRGSHHHHHHGMASGLDSPTGIDFSDITANSFTVHWIAPRATITGYRIRHHPEHFSGRPREDRVIPHSRNSIT
LTNLTPGTEYVVSIVALNGREESPPLIGQQSTVSDVPRDLEVVAATPTSLLISWDAPAVTVRYYRITYGETG
GNSPVQEFTVPGSKSTATISGLKPGVDYTITVYAVTGRGDSPASSKPISINYRTSKLEPKSSDTPPGSPRSP
EPKSSDTPPGSPRSGRIKQLEDKIEELLSKIYHLENETARLKKLIGELEDKIENLAC]

£ S A A A U A A O O |

@ 3 | ligands used to immobilise cells on surfaces via

*  9th type lll FN domain synergy site (PHSRN)
* 10th type lll FN domain RGD site

@ < 3 | ligand oligomers facilitate increased binding
* Oligomerisation accomplished via 5 heptad repeats based on GCN4

leucine zipper
* |/L placed variously @ a and d positions to promote di-, tri- & tetramerisation

* Thiol-linked immobilisation to surface
achieved via C-terminal Cys

* Question: do the ligands oligomerise as
designed!?




Construction of hydrodynamic bead models

MRGSHHHHHHGMASGLDSPTGIDFSDITANSFTVHWIAPRATITGYRIRHHPEHFSGRPREDRVPHSRNSIT
LTNLTPGTEYVVSIVALNGREESPPLIGQQSTVSDVPRDLEVVAATPTSLLISWDAPAVTVRYYRITYGETG
GNSPVQEFTVPGSKSTATISGLKPGVDYTITVYAVTGRGDSPASSKPISINYRTSKLEPKSSDTPPGSPRSP
EPKSSDTPPGSPRSGRIKQLEDKIEELLSKIYHLENETARLKKLIGELEDKIENLAC]

£ S A A A U A A O O |

*  From vector (including His-tag) — too short for e.g. SWISSMODEL
*  FN Il 9-10 domain pair homology model (SWISSMODEL)

* Synthesised “missing beads”
* Coiled-coil (42 a.a.) — SWISSMODELs generated for underlined segment

Kreiner et al.,, (2009) Biophysical Chemistry 142 34-39



Oligomerisation of synthetic polyvalent integrin
o 3 ligands - AUC SV:c(s) reveals complex
composition

—5 mg/ml
-=-=3 mg/ml

€6 _J° )
dimer S N—
Pty s "Ll A
b g\gl"\
[ . 9
trimer

—4 mg/ml
-=-=3 mg/ml

s)

“tetramer’ T




AUC SV + DTT: c(s) composition simplified

“trimer”

“tetramer’’

c(s)

c(s)

-
e ca.
-

;—_ -
———
————
-

6
— 1 mg/ml
===0.1 mg/ml
i o ’%S&H Ai‘.tqg,t"".‘f'f‘f“‘“
#" R \’1“,\:;“_\'{ e
— 1 mg/ml
===-0.1 mg/ml

—1 mg/ml
===0.1 mg/ml|

6 7 Kreiner et al., (2009) Biophysical Chemistry 142 34-39



AUC background
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Data analysis

Example: simple model-independent investigation of a
hetero-association

Detergent solubilised systems
Hydrodynamic bead modelling (HBM)

Example: oligomerisation of synthetic polyvalent
integrin &3 | ligands



AUC tutorials

* Setting up and running AUC experiments
* Tutorial paper

* Lebowitz, ., M.S. Lewis, and P. Schuck, Modern analytical

ultracentrifugation in protein science:A tutorial review. Protein
Science, 2002. 11(9): p. 2067-2079.

* AUC user guide from Demeler lab

* http://www.uslims.uthscsa.edu/AUCuserGuideVolume- | -
Hardware.pdf

* Data analysis

* Using SEDFIT & SEDPHAT
* http://www.analyticalultracentrifugation.com/default.htm
* Using UltraScan

* http://www.ultrascan.uthscsa.edu



AUC tutorials

YoulTH

* Alexander Bepperling

 Aggregation analysis and beyond analytical ultracentrifugation in the
biopharmaceutical industry

* https://www.youtube.com/watch?v=IliERbl-Xz4c
* Borries Demeler

* Advances in sedimentation analysis

* https://www.youtube.com/watch?v=zuAwWO|ZtkM
* Chad Brautigam

* Exploring the stoichiometry of macromolecular complexes using multi signal
sedimentation velocity analytical ultracentrifugation

* https://www.youtube.com/watch?v=eabtvKF8zkA
* John Burgner

* Quantitative determination of reaction stoichiometry, interaction energies, and
something else

* https://www.youtube.com/watch?v=ivRodzqWVjS8
*  Andrew Herr

* Analytical ultracentrifugation as a complementary technique for structural analysis
of proteins and macromolecular complexes

* https://www.youtube.com/watch?v=Kw72fyaiQsw
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Questions!

If Apple
made a car...
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would it have
Windows!?

If a dog wore pants would he wear them
like this or like this?
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